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PRAKATA 

 

Puji syukur kami panjatkan ke hadirat Tuhan Yang Maha Esa atas 

tersusunnya buku BIM Simulation ini sebagai salah satu referensi 

pembelajaran di bidang arsitektur, teknik sipil, dan konstruksi. Buku ini 

hadir untuk menjawab kebutuhan dunia pendidikan dan industri dalam 

memahami serta menerapkan teknologi Building Information Modeling 

(BIM) yang semakin berkembang pesat di era digital. 

 

Penyusunan buku ini berfokus pada pemahaman konsep dasar 

hingga praktik penggunaan Digital Simulation BIM, yang mencakup 

pemodelan 3D, penjadwalan berbasis 4D, hingga analisis biaya proyek 

5D. Melalui pendekatan pembelajaran interaktif, buku ini diharapkan 

mampu menjadi panduan bagi mahasiswa, dosen, maupun praktisi 

untuk menguasai BIM secara lebih sistematis, terstruktur, dan aplikatif. 

 

Kami menyadari bahwa buku ini masih jauh dari sempurna. Oleh 

karena itu, kritik dan saran yang membangun dari pembaca sangat kami 

harapkan demi penyempurnaan edisi berikutnya. Semoga kehadiran 

buku BIM Simulation ini dapat memberikan manfaat nyata, 

memperkaya wawasan, serta meningkatkan kompetensi pembaca dalam 

menghadapi tantangan dunia konstruksi modern. 

 

 

 

Annisa’ Carina
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BAB I 

PENGENALAN BUILDING INFORMATION 

MODELING 

 

1.1 CAPAIAN PEMBELAJARAN 

1. Mahasiswa dapat mendefinisikan istilah Building Information 

Modeling (BIM) dengan benar. 

2. Mahasiswa mampu menjelaskan fungsi dan tujuan utama 

penggunaan BIM dalam proyek konstruksi. 

3. Mahasiswa dapat menguraikan sejarah singkat dan 

perkembangan BIM dalam industri konstruksi. 

4. Mahasiswa memahami relevansi BIM terhadap kebutuhan 

dan tantangan konstruksi modern. 

5. Mahasiswa dapat menerapkan rubrik penilaian untuk menilai 

proyek BIM baik secara individu maupun kelompok  

 

1.2 PENDAHULUAN 

Building Information Modeling (BIM) merupakan pendekatan 

revolusioner dalam perencanaan, perancangan, pembangunan, dan 

pengelolaan infrastruktur bangunan yang mengintegrasikan berbagai 

data ke dalam satu model digital tiga dimensi. BIM bukan hanya 

sekadar representasi visual, tetapi mencakup informasi menyeluruh 

tentang elemen-elemen bangunan, seperti spesifikasi material, biaya, 

jadwal, dan siklus hidup aset. Dengan BIM, para pelaku konstruksi 

dapat bekerja secara kolaboratif dalam satu ekosistem digital yang 

saling terintegrasi. 
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Kemunculan BIM dilatarbelakangi oleh kebutuhan akan efisiensi, 

akurasi, dan transparansi dalam dunia konstruksi, yang selama 

bertahun-tahun menghadapi tantangan besar seperti pembengkakan 

anggaran, keterlambatan proyek, dan miskomunikasi antar tim. 

Teknologi ini pertama kali dikembangkan pada akhir abad ke-20, dan 

semakin masif diadopsi pada awal 2000-an seiring berkembangnya 

perangkat lunak seperti Autodesk Revit, ArchiCAD, dan Tekla 

Structures. BIM memungkinkan simulasi proyek secara komprehensif 

sebelum pelaksanaan di lapangan. 

Salah satu keunggulan utama BIM adalah kemampuannya dalam 

mendeteksi konflik desain atau clash detection sebelum konstruksi 

dimulai. Hal ini secara signifikan mengurangi kesalahan lapangan dan 

mempercepat proses konstruksi. Selain itu, BIM juga mendukung 

perencanaan berbasis data dan pengambilan keputusan yang lebih baik, 

karena informasi teknis tersedia secara real-time dalam satu platform. 

Dalam konteks pendidikan teknik sipil, pemahaman terhadap 

BIM menjadi kompetensi dasar yang wajib dikuasai oleh mahasiswa. 

Pergeseran paradigma industri dari proses manual menuju digitalisasi 

menuntut institusi pendidikan tinggi untuk segera mengadaptasi 

kurikulum berbasis teknologi terkini. Pembelajaran berbasis BIM dapat 

membuka peluang kolaborasi multidisipliner yang lebih baik, sekaligus 

membekali mahasiswa dengan keterampilan yang relevan di era 

industri 4.0 dan 5.0. 

Dunia Usaha dan Dunia Industri (DUDIKA) kini menjadikan 

penguasaan BIM sebagai salah satu indikator kesiapan kerja lulusan 

teknik sipil. Banyak perusahaan konstruksi mensyaratkan kemampuan 

mengoperasikan software BIM serta memahami workflow digital 
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proyek dalam proses rekrutmen. Oleh karena itu, pengenalan BIM sejak 

dini dalam pendidikan menjadi sangat krusial untuk meningkatkan daya 

saing lulusan di pasar kerja global. 

Dengan melihat perkembangan tersebut, pemanfaatan BIM 

tidak hanya menjadi keharusan di lapangan, tetapi juga menjadi fokus 

utama dalam pengembangan media pembelajaran digital di lingkungan 

akademik. Integrasi BIM dalam sistem pembelajaran memberikan 

pengalaman simulasi nyata kepada mahasiswa, sekaligus menjembatani 

kesenjangan antara teori dan praktik di dunia profesional. 

1.3 PEMANFAATAN BIM DALAM PEMBELAJARAN 

Pemanfaatan BIM dalam pembelajaran manajemen proyek 

konstruksi memberikan kontribusi besar dalam meningkatkan 

pemahaman mahasiswa terhadap kompleksitas proyek konstruksi 

secara menyeluruh. BIM menyediakan lingkungan digital yang 

memungkinkan mahasiswa untuk melihat keterkaitan antar elemen 

proyek dari desain, estimasi biaya, hingga penjadwalan dan 

pelaksanaan konstruksi. Hal ini membantu menciptakan pengalaman 

belajar yang lebih kontekstual dan mendekati kondisi nyata di 

lapangan. 

Dalam manajemen proyek, BIM memungkinkan mahasiswa 

untuk mempelajari proses 4D scheduling (penjadwalan proyek berbasis 

waktu) dan 5D estimation (estimasi biaya), yang tidak dapat dilakukan 

hanya dengan gambar 2D atau dokumen konvensional. Melalui 

simulasi BIM, mahasiswa dapat melakukan analisis waktu dan biaya 

berdasarkan model yang dinamis dan dapat diperbarui secara real-time. 

Dengan demikian, keterampilan manajerial seperti pengambilan 
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keputusan, alokasi sumber daya, dan mitigasi risiko dapat dilatih secara 

lebih efektif. 

Selain itu, BIM juga mendukung kolaborasi tim yang menjadi 

aspek penting dalam manajemen proyek. Dalam pembelajaran berbasis 

BIM, mahasiswa diajak untuk bekerja secara kolaboratif dalam 

menyelesaikan satu proyek digital, seolah-olah mereka adalah bagian 

dari tim proyek sungguhan. Setiap mahasiswa dapat diberi peran 

spesifik seperti estimator, scheduler, drafter, atau manajer proyek yang 

menuntut mereka untuk saling berkoordinasi dan memahami peran satu 

sama lain, sesuai praktik dunia kerja yang sesungguhnya. 

Di sisi lain, dalam konteks pembelajaran desain, BIM 

memberikan pendekatan visual dan integratif yang sangat bermanfaat 

bagi mahasiswa teknik sipil maupun arsitektur. Melalui BIM, 

mahasiswa dapat merancang bangunan atau infrastruktur secara tiga 

dimensi sambil langsung mengamati interaksi antara elemen-elemen 

desain. Ini meningkatkan pemahaman mereka terhadap konsep spasial, 

struktur, material, dan sistem bangunan, serta mendorong desain yang 

lebih efisien dan berorientasi pada keberlanjutan. 

BIM juga mendorong pendekatan desain berbasis data (data-

driven design), di mana mahasiswa tidak hanya membuat model visual, 

tetapi juga mengisi dan memproses informasi teknis dari setiap 

komponen bangunan. Informasi ini meliputi jenis material, harga 

satuan, volume, hingga performa energi. Dengan pendekatan ini, 

mahasiswa terbiasa berpikir logis, analitis, dan berbasis data, sesuai 

tuntutan desain modern yang tidak hanya estetis tetapi juga fungsional 

dan ekonomis. 
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Secara keseluruhan, integrasi BIM dalam pembelajaran 

manajemen proyek dan desain memberikan nilai tambah yang besar 

dalam pendidikan teknik sipil. Mahasiswa tidak hanya memahami teori 

dan konsep, tetapi juga memiliki keterampilan praktis dalam 

menggunakan teknologi yang telah menjadi standar industri. Hal ini 

menjadikan mereka lebih siap menghadapi dunia kerja dan mampu 

bersaing dalam era digitalisasi industri konstruksi. 

1.4 RUBIK PENILAIAN PROYEK BIM MAHASISWA 

Untuk memastikan proses pembelajaran dan penilaian berjalan 

secara objektif, sistematis, dan sesuai dengan capaian pembelajaran 

yang diharapkan, diperlukan suatu instrumen evaluasi yang 

komprehensif. Dalam konteks implementasi proyek berbasis BIM di 

kelas teknik sipil, rubrik penilaian disusun guna menilai berbagai aspek 

penting yang mencerminkan kompetensi teknis, manajerial, dan 

kolaboratif mahasiswa. Rubrik pada Tabel 1 tidak hanya menilai hasil 

akhir berupa model digital, tetapi juga menilai proses pengerjaan, kerja 

tim, dan kemampuan presentasi mahasiswa secara menyeluruh. 

Tabel 1. Komponen Penilaian Proyek BIM Mahasiswa 

Aspek Penilaian Kriteria Bobot (%) 

Pemodelan 3D Ketepatan dimensi, struktur, dan 

komponen bangunan 

25% 

Integrasi Data 

BIM 

Kelengkapan data material, 

volume, dan informasi biaya 

20% 
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Jadwal Proyek Kesesuaian urutan kegiatan, 

logika jadwal, dan kurva S 

15% 

Kerja Tim dan 

Kolaborasi 

Distribusi tugas, komunikasi 

antar anggota, dan laporan kerja 

kelompok 

10% 

Presentasi Proyek Kejelasan penyampaian, 

visualisasi model, dan 

argumentasi teknis 

10% 

Ketepatan 

Administrasi 

Kelengkapan dokumen: gambar 

kerja, estimasi biaya 

20% 

 

Tabel di atas menunjukkan komponen-komponen penilaian 

proyek BIM yang terdiri dari tujuh aspek utama: pemodelan 3D, 

integrasi data, penjadwalan proyek, inovasi, kerja tim, presentasi, dan 

kelengkapan administrasi. Masing-masing aspek diberikan bobot sesuai 

tingkat kepentingannya terhadap keseluruhan proyek. Dengan adanya 

rubrik ini, diharapkan mahasiswa dapat memahami kriteria 

keberhasilan proyek BIM secara lebih jelas, serta termotivasi untuk 

mengembangkan kompetensinya secara holistik dan profesional sesuai 

standar industri konstruksi digital saat ini. 
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BAB II 

PENGAPLIKASIAN BIM 3D 

 

2.1 CAPAIAN PEMBELAJARAN 

1. Mahasiswa dapat menjelaskan konsep dasar Building 

Information Modeling (BIM) 3D sebagai representasi digital 

dari elemen fisik dan fungsional bangunan. 

2. Mahasiswa dapat mengidentifikasi komponen-komponen 

utama dalam model BIM 3D, termasuk arsitektur, dan 

struktur. 

3. Mahasiswa dapat menggunakan perangkat lunak untuk 

membuat model 3D bangunan secara tepat dan sistematis. 

4. Mahasiswa dapat mengintegrasikan data teknis (seperti jenis 

material, dimensi, dan properti elemen) ke dalam model 3D. 

5. Mahasiswa dapat mengevaluasi kualitas dan akurasi model 

BIM 3D berdasarkan standar desain dan dokumentasi teknis. 

6. Mahasiswa dapat menyajikan model 3D sebagai alat 

komunikasi visual dan teknis antar tim proyek dalam proses 

perencanaan dan perancangan  

 

2.2 DESAIN 3D (BIM 3D) 

Penerapan BIM dalam bentuk tiga dimensi (3D) menjadi langkah 

awal yang sangat penting dalam proses digitalisasi proyek konstruksi. 

BIM 3D memberikan representasi visual yang akurat dan informatif 

terhadap elemen bangunan, sehingga memudahkan seluruh tim proyek 

untuk memahami desain dan melakukan koordinasi teknis sejak tahap 
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perencanaan. Dengan BIM 3D, para perencana, arsitek, dan insinyur 

dapat mendeteksi potensi konflik desain secara dini sebelum konstruksi 

fisik dimulai. 

Dalam konteks pembelajaran dan praktik teknik sipil, 

penggunaan perangkat lunak desain 3D seperti Google SketchUp dan 

AutoCAD sering dijadikan sebagai sarana pengenalan awal terhadap 

konsep BIM. Google SketchUp, dengan antarmukanya yang intuitif, 

memungkinkan pengguna untuk dengan mudah memodelkan bentuk 

bangunan secara tiga dimensi, mulai dari dinding, lantai, atap, hingga 

furnitur dan elemen interior lainnya. Sementara itu, AutoCAD 

memberikan presisi tinggi dalam penggambaran teknis, termasuk 

pembuatan detail struktur dan koneksi antar komponen. 

Meskipun kedua perangkat lunak ini tidak sepenuhnya masuk 

dalam kategori BIM secara utuh, mereka dapat digunakan sebagai 

pendekatan awal dalam pembelajaran BIM 3D. Google SketchUp, 

misalnya, dapat diintegrasikan dengan plugin tambahan seperti Sefaira 

untuk analisis energi atau Trimble Connect untuk kolaborasi proyek, 

sehingga mendekati konsep BIM. AutoCAD pun memiliki fitur-fitur 

3D modeling dan kini terhubung dengan platform Autodesk lainnya 

seperti Revit, yang memang dirancang khusus untuk BIM. 

Penerapan BIM 3D dalam proyek juga memungkinkan 

pembuatan detail komponen bangunan secara akurat, seperti struktur 

kolom, balok, sambungan baja, dan elemen arsitektural. Dengan 

AutoCAD, mahasiswa atau profesional dapat menggambar detil teknis 

berdasarkan standar konstruksi yang berlaku, termasuk ketebalan pelat, 

jenis sambungan, dan dimensi elemen struktural. Model ini kemudian 

dapat diimpor ke platform BIM seperti Revit untuk integrasi informasi. 
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Di sisi lain, Google SketchUp sering digunakan untuk 

memodelkan konsep arsitektural awal secara cepat. Misalnya, dalam 

tahap pra-rencana, desainer dapat menyusun model massing dan layout 

bangunan dalam hitungan jam, memberikan gambaran visual awal yang 

bisa langsung didiskusikan dengan klien atau tim. Model 3D dari 

SketchUp juga bisa diekspor dalam berbagai format (seperti .DWG, 

.IFC, atau .OBJ) untuk disambungkan ke software BIM yang lebih 

kompleks. 

Salah satu manfaat besar dari penerapan BIM 3D adalah deteksi 

benturan (clash detection), yaitu kemampuan untuk mengidentifikasi 

konflik antara komponen bangunan yang berbeda, seperti tabrakan 

antara saluran mekanikal dengan balok struktur. Meskipun fitur ini 

lebih dikenal dalam software BIM seperti Navisworks atau Revit, 

model 3D dari AutoCAD dan SketchUp dapat digunakan sebagai 

bagian dari proses deteksi jika diintegrasikan dengan benar ke dalam 

workflow proyek. 

Dalam lingkungan pendidikan tinggi teknik sipil, penguasaan 

terhadap SketchUp dan AutoCAD 3D dianggap sebagai langkah 

transisi yang efektif sebelum mempelajari BIM secara komprehensif. 

Mahasiswa dapat memahami konsep ruang, proporsi, dan hubungan 

antar komponen bangunan dengan membangun model 3D yang 

realistik. Hal ini sangat membantu dalam mempercepat pemahaman 

mereka ketika berpindah ke software BIM tingkat lanjut. 

Kelebihan SketchUp dalam visualisasi cepat dan kemudahan 

penggunaan menjadikannya ideal untuk pemodelan awal dan studi 

desain alternatif. Sebaliknya, AutoCAD unggul dalam presisi dimensi 

dan sangat penting saat mahasiswa atau profesional membuat shop 
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drawing atau gambar kerja teknis yang menjadi acuan di lapangan. 

Kombinasi keduanya menciptakan dasar pengetahuan yang kuat dalam 

pengembangan BIM 3D. 

Selain itu, integrasi antara desain 2D dan 3D dengan 

pengembangan aplikasi BIM memungkinkan kolaborasi dengan 

penjadwalan dan perkiraan biaya yang lebih baik. Tim arsitektur, 

struktur, dan MEP (mekanikal, elektrikal, dan plumbing) dapat bekerja 

pada satu proyek dengan berbagai tools namun tetap dalam satu 

ekosistem digital yang sinkron. Hal ini mencerminkan esensi dari BIM 

sebagai proses yang kolaboratif, informatif, dan terkoneksi. 

Secara keseluruhan, penerapan BIM 3D melalui Google 

SketchUp dan AutoCAD merupakan fondasi penting dalam 

pengembangan kemampuan digital mahasiswa teknik sipil. Dengan 

keterampilan ini, mahasiswa tidak hanya mampu menggambar dan 

memvisualisasikan bangunan, tetapi juga memahami logika teknis dan 

integrasi data dalam proyek konstruksi modern. Ke depan, 

keterampilan ini akan sangat relevan dan dibutuhkan di dunia industri 

yang semakin mengandalkan teknologi BIM dalam setiap tahap 

pembangunan 

2.3 ALUR KERJA (WORKFLOW) BIM 3D 

1. Konseptualisasi Desain (SketchUp) 

a. Mahasiswa membuat model 3D awal bangunan secara 

visual dan cepat menggunakan SketchUp. 

b. Fokus pada bentuk massa, tata ruang, dan orientasi 

bangunan. 

c. Latihan desain yang dibuat antara lain: 
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1) Pondasi Footplate 

Pondasi footplate digunakan ketika kondisi 

bangunan dan tanah memungkinkan penerapan 

pondasi dangkal. Jenis pondasi ini umumnya dipilih 

jika beban struktur yang harus ditopang tidak terlalu 

besar, seperti pada bangunan satu atau dua lantai. 

Selain itu, pondasi footplate sangat efektif 

diterapkan pada lokasi yang memiliki tanah dengan 

daya dukung cukup baik, terutama pada kedalaman 

dangkal sekitar 1 hingga 2 meter.  

Berikut adalah cara mendesain pondasi 

footplate dengan Google SketchUp seperti gambar. 

 

Gambar 1.1 Pondasi Footplate 

 

   1. Siapkan Workspace 
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• Buka Google SketchUp 

• Pilih template “Architectural Design – 

Millimeters” atau “Meters” sesuai 

kebutuhan 

• Atur layer dan tag untuk 

mengelompokkan elemen (misal: pondasi, 

tulangan, tanah) 

   2. Gambar Footplate (Pelat Pondasi) 

• Gunakan tool Rectangle untuk 

menggambar alas pondasi: 

o Misalnya ukuran: 1.5 m x 1.5 m 

• Gunakan Push/Pull untuk memberikan 

ketebalan pelat, misalnya 30 cm: 

o Klik pada persegi → tarik ke atas → 

ketik 0.3m → Enter 

   3. Tambahkan Kolom di Atas Footplate 

• Gunakan Rectangle lagi di atas pelat 

untuk kolom: 

o Misalnya kolom 30 x 30 cm 

• Gunakan Push/Pull ke atas untuk 

membuat tinggi kolom (misalnya 3 meter) 

   4. Tambahkan Tulangan (Opsional – untuk 

Visual) 

Tulangan di SketchUp tidak bersifat struktural, 

tapi bisa divisualisasikan: 

• Gunakan tool Circle untuk membuat besi: 
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o Buat diameter 12 mm → ketik 

0.006m (karena radius) 

• Gunakan Move + Copy dan Rotate untuk 

menempatkan tulangan longitudinal 

• Gunakan Follow Me untuk membuat 

begel (stirrup) melingkar persegi 

• Bisa juga pakai plugin “Profile Builder” 

atau “1001bit Tools” untuk mempercepat 

   5. Tambahkan Material dan Warna 

• Gunakan Paint Bucket tool 

• Pilih material seperti Concrete, Rebar, 

atau Soil 

• Terapkan ke footplate, kolom, dan tanah 

untuk memperjelas tampilan 

   6. Buat Tanah dan Kontur (Jika Perlu) 

• Gunakan Rectangle besar sebagai tanah 

• Gunakan Push/Pull untuk memberikan 

ketebalan 

• Atur posisi footplate sedikit tenggelam 

dalam tanah (menggambarkan elevasi 

lapangan) 

   7. Tambahkan Dimensi dan Keterangan 

• Gunakan Dimension Tool untuk 

menunjukkan ukuran footplate, kolom, 

dan ketebalan 
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• Gunakan Text Tool untuk memberi label 

seperti “Footplate 1.5m x 1.5m x 0.3m” 

   8. Export Gambar / Model 

• Untuk dokumentasi: File → Export → 2D 

Graphic (JPG, PNG, atau PDF) 

• Untuk BIM atau CAD: File → Export → 

3D Model → pilih DWG atau IFC (jika 

plugin tersedia). 

 

2) Sloof 

Sloof adalah elemen struktur horizontal dari 

bangunan yang terletak di atas pondasi dan 

berfungsi untuk mengikat antar pondasi serta 

mendistribusikan beban dari dinding ke pondasi 

secara merata. Sloof biasanya terbuat dari beton 

bertulang dan memiliki posisi sejajar dengan 

permukaan tanah atau sedikit di atasnya. Selain itu, 

sloof juga membantu menjaga kestabilan struktur 

dinding terhadap gaya lateral seperti gempa atau 

pergeseran tanah. 

Berikut adalah cara lengkap mendesain sloof 

menggunakan Google SketchUp, mulai dari tahap 

modeling hingga menambahkan elemen visual 

seperti material dan tulangan pada gambar. 
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Gambar 1.2 Sloof 

   1. Siapkan Lingkungan Kerja 

• Buka SketchUp dan pilih template: 

Architectural Design – Millimeters atau 

Meters 

• Atur Unit melalui: Window → Model 

Info → Units 

• Buat Layer/Tag untuk pengelompokan: 

misalnya “Pondasi”, “Sloof”, “Kolom” 

   2. Gambar Denah Sloof (Garis Dasar) 

• Gunakan Line Tool atau Rectangle Tool 

untuk menggambar jalur sloof sesuai 

denah pondasi 

• Contoh: jalur sloof sepanjang 3 meter di 

atas pondasi batu kali atau footplate 

   3. Buat Volume Sloof 
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• Gunakan Rectangle Tool: 

o Gambar penampang sloof (misalnya: 

lebar 20 cm, tinggi 30 cm) 

• Gunakan Push/Pull Tool: 

o Tarik penampang tersebut sepanjang 

jalur sloof yang diinginkan (misalnya 

3 meter) 

o Ketik 3m lalu tekan Enter 

   4. Letakkan Sloof di Atas Pondasi 

• Gunakan Move Tool untuk menggeser 

sloof ke atas pondasi (sekitar +0.2 m dari 

permukaan tanah) 

• Pastikan sloof berada tepat di atas 

footplate atau batu kali 

   5. Tambahkan Tulangan (Opsional – 

Visualisasi) 

Untuk presentasi atau dokumentasi, Anda bisa 

menambahkan visual tulangan: 

• Gunakan Circle Tool: 

o Buat diameter tulangan (misalnya: 

ϕ12 mm → radius = 0.006m) 

• Gunakan Push/Pull untuk extrude besi 

menjadi panjang 

• Copy dan Rotate untuk menggandakan 

tulangan longitudinal 
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• Gunakan Rectangle + Follow Me atau 

Path Copy (dari plugin) untuk membuat 

begel 

  Gunakan plugin seperti: 

• 1001bit Tools 

• Profile Builder 

• Curic Stretch (untuk dynamic modeling) 

   6. Beri Material dan Warna 

• Klik Paint Bucket Tool 

• Terapkan material beton pada sloof 

• Gunakan warna abu-abu untuk beton, 

merah untuk tulangan 

   7. Tambahkan Dimensi & Keterangan 

• Gunakan Tape Measure Tool dan 

Dimension Tool (Tools → Dimensions) 

• Tambahkan teks dengan Text Tool untuk 

memberi label: "Sloof 20x30 cm", dll 

   8. Export Gambar atau Model 

• Untuk gambar: File → Export → 2D 

Graphic (PNG/JPG/PDF) 

• Untuk 3D: File → Export → 3D Model 

(.SKP, .DWG, .DAE) 

 

3) Kolom 

Kolom adalah elemen struktur vertikal pada 

bangunan yang berfungsi untuk menyalurkan beban 
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dari struktur atas (seperti balok, pelat, dan atap) ke 

elemen struktur bawah seperti pondasi. Kolom 

merupakan komponen penting karena menentukan 

kekuatan dan kestabilan sebuah bangunan terhadap 

beban vertikal dan lateral (seperti gempa atau 

angin). 

Berikut adalah cara mendesain kolom seperti 

gambar dengan Google SketchUp, cocok untuk 

pemodelan arsitektur atau struktur bangunan secara 

3D: 

 

Gambar 1.3 Kolom 

 

   1. Buka SketchUp dan Atur Template 
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• Buka SketchUp → pilih template: 

Architectural Design – Millimeters atau 

Meters 

• Pastikan satuan sesuai kebutuhan: 

Window → Model Info → Units 

   2. Buat Denah Lokasi Kolom 

• Gunakan Rectangle Tool atau Line Tool 

untuk menandai posisi kolom pada denah 

bangunan. 

• Ini bisa berupa titik-titik grid tempat 

kolom akan diletakkan (misalnya: titik 

A1, A2, B1, B2) 

   3. Gambar Penampang Kolom 

• Pilih Rectangle Tool 

o Klik dan tarik untuk membuat ukuran 

kolom (contoh: 0.3m x 0.3m untuk 

kolom 30x30 cm) 

• Gunakan Push/Pull Tool 

o Klik area kotak yang dibuat → tarik 

ke atas → ketik tinggi kolom (misal 

3m) → tekan Enter 

   4. Buat Beberapa Kolom (Jika Perlu) 

• Gunakan Move Tool + Ctrl (Copy) 

untuk menduplikasi kolom ke titik 

lainnya. 
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• Jika banyak kolom teratur, gunakan 

perintah array: 

o Misalnya: setelah meng-copy kolom 

ke kanan sejauh 4 meter, ketik x4 lalu 

Enter → akan muncul 4 kolom 

berjajar 

   5. Tambahkan Tulangan (Opsional – 

Visualisasi) 

Untuk keperluan presentasi atau visualisasi: 

• Gunakan Circle Tool: 

o Buat diameter tulangan (misal: Ø12 

mm → radius = 0.006m) 

• Gunakan Push/Pull Tool: 

o Buat batang besi memanjang setinggi 

kolom 

• Copy tulangan ke empat sudut bagian 

dalam kolom 

• Gunakan Rectangle + Follow Me untuk 

membuat begel (stirrup) melingkari 

tulangan pokok 

   6. Beri Material dan Warna 

• Gunakan Paint Bucket Tool 

• Terapkan material Concrete pada kolom 

• Gunakan warna abu-abu atau tekstur 

beton, dan warna merah/biru untuk 

tulangan 
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   7. Tambahkan Dimensi dan Label 

• Gunakan Dimension Tool (Tools → 

Dimensions) untuk memberi ukuran lebar 

dan tinggi kolom 

• Gunakan Text Tool untuk memberi 

keterangan seperti: 

“Kolom 30x30 cm, 4D13 + Begel Ø8-

150” 

   8. Simpan dan Ekspor Model 

• File → Save As untuk menyimpan file 

.skp 

• Untuk gambar: File → Export → 2D 

Graphic (JPG/PNG/PDF) 

• Untuk model 3D: Export → 3D Model 

(DWG/DAE) 

 

4) Balok 

Balok adalah elemen struktur horizontal dalam 

bangunan yang berfungsi untuk menahan dan 

menyalurkan beban dari pelat (lantai atau atap) ke 

kolom. Balok biasanya terbuat dari beton bertulang, 

baja, atau kayu, tergantung jenis konstruksi. Balok 

bekerja dengan menahan gaya lentur (momen) dan 

geser, sehingga harus dirancang agar cukup kuat 

terhadap beban vertikal yang dikenakan padanya. 
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Berikut adalah cara mendesain balok seperti 

gambar dengan Google SketchUp. 

 

Gambar 1.4 Balok 

 

   1. Buka SketchUp & Siapkan Template 

• Buka SketchUp 

• Pilih template Architectural Design – 

Millimeters atau Meters 

• Atur satuan jika perlu: Window → Model 

Info → Units 

   2. Gambarlah Penampang Balok 

Misalnya, balok beton 20x40 cm: 

• Pilih Rectangle Tool (R) 

o Klik pada area kerja → ketik ukuran 

0.2, 0.4 (untuk 20 cm x 40 cm) → 

tekan Enter 

• Gunakan Push/Pull Tool (P) 
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o Klik permukaan kotak → tarik 

sepanjang bentang balok (misal 3m) 

→ tekan Enter 

   3. Pindahkan Balok ke Posisi yang Benar 

• Gunakan Move Tool (M) untuk 

menaikkan posisi balok ke atas kolom 

atau pelat 

• Klik titik dasar balok → arahkan ke titik 

referensi lain di model 

   4. Salin Balok Jika Diperlukan 

• Pilih balok → tekan Move (M) + Ctrl 

(untuk copy) 

• Tarik dan ketik jarak (misal 4m) → x3 

untuk membuat 3 salinan 

   5. Berikan Material 

• Pilih Paint Bucket Tool (B) → cari 

material Concrete atau buat warna abu-

abu 

• Klik pada permukaan balok untuk 

menerapkan material 

   6. Tambahkan Dimensi 

• Gunakan Dimension Tool (Tools → 

Dimensions) untuk menunjukkan: 

o Tinggi balok 

o Lebar balok 

o Panjang bentang 
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   7. (Opsional) Tambahkan Tulangan Visual 

Untuk presentasi atau visualisasi struktur: 

• Gunakan Circle Tool 

o Buat lingkaran diameter tulangan 

(misal Ø12 → radius 0.006m) 

• Gunakan Push/Pull untuk membuat 

batang tulangan 

• Salin tulangan ke tepi balok 

• Buat begel (stirrup) dengan Rectangle + 

Follow Me 

   8. Gunakan Komponen & Group 

• Jadikan balok sebagai Group atau 

Component agar mudah dimodifikasi dan 

tidak menempel ke objek lain 

o Klik kanan → Make Group atau 

Make Component 

   9. Ekspor Hasil 

• Untuk gambar: File → Export → 2D 

Graphic 

• Untuk model 3D: File → Export → 3D 

Model (.dae, .dwg, dll) 

 

5) Atap 

Atap adalah bagian paling atas dari suatu 

bangunan yang berfungsi utama untuk melindungi 

ruang di bawahnya dari cuaca, seperti hujan, panas 
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matahari, angin, dan salju. Selain fungsi 

perlindungan, atap juga berperan dalam aspek 

estetika, ventilasi, dan bahkan efisiensi energi pada 

suatu bangunan. 

Berikut adalah cara mendesain atap dengan 

Google SketchUp seperti pada gambar. 

 

Gambar 1.5 Atap 

 

   1. Siapkan Bangunan atau Dinding 

Sebelum mendesain atap, pastikan kamu 

sudah memiliki denah atau dinding 

bangunan 3D. 

• Buat denah persegi/rectangular 

menggunakan Rectangle Tool (R). 

• Gunakan Push/Pull Tool (P) untuk 

menarik ke atas dan membentuk dinding. 
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Contoh: tinggi dinding 3 meter → ketik 3m 

setelah tarik ke atas. 

   2. Gambar Bidang Dasar Atap 

• Klik top face (permukaan atas dinding) 

bangunan. 

• Gunakan Line Tool (L) untuk 

menggambar garis tengah (midline) jika 

ingin atap pelana (gable roof). 

o Temukan titik tengah pada sisi 

panjang → tarik garis tegak lurus ke 

sisi berlawanan. 

   3. Buat Kemiringan Atap (Roof Pitch) 

• Pilih Move Tool (M). 

• Klik garis tengah atau titik puncak atap → 

arahkan ke atas. 

• Tarik sampai sudut kemiringan sesuai, 

atau ketik tinggi tertentu, misalnya 1.5m. 

   4. Gunakan Follow Me (Opsional untuk Atap 

Limas) 

Untuk bentuk kompleks (limas, perisai): 

• Gambar profil atap di satu sisi (pakai Arc 

Tool atau Line Tool). 

• Buat jalur mengikuti bentuk bangunan. 

• Gunakan Follow Me Tool untuk 

membentuk atap melingkari bangunan. 

   5. Tambahkan Overstek / Dak Atap 
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• Gunakan Offset Tool (F) pada bidang 

atas untuk membuat overstek. 

• Misalnya offset 0.5m untuk atap 

menjorok keluar 50 cm. 

• Tarik offset ke atas dengan Push/Pull 

untuk membuat ketebalan atap. 

   6. Gunakan Plugin Atap Otomatis (Opsional) 

Untuk membuat atap secara instan, kamu bisa 

menggunakan plugin: 

• 1001bit Tools (gratis) 

• HouseBuilder Extension (untuk atap 

kayu) 

• Roof by TIG (untuk atap kompleks) 

   7. Beri Material Penutup Atap 

• Pilih Paint Bucket Tool (B). 

• Pilih material: Roofing, Tile, Metal, atau 

buat tekstur genteng sendiri. 

• Klik permukaan atap untuk menerapkan 

material. 

   8. Tambahkan Talang atau Lisplank 

• Gunakan Line Tool + Push/Pull untuk 

menggambar dan mengangkat tepi atap, 

atau 

tambahkan komponen talang/gutter dari 

3D Warehouse. 

   9. Group Atap 
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• Seleksi semua bagian atap. 

• Klik kanan → Make Group atau Make 

Component agar mudah dimodifikasi. 

 

2. Detailing Teknis (AutoCAD) 

a. Model awal dipertajam di AutoCAD untuk menggambar 

detail struktural dan arsitektural seperti pondasi, kolom, 

balok, dan sambungan. 

b. Dimensi akurat sesuai standar teknik sipil. 

c. Desain yang dibuat antara lain: 

     Langkah-Langkah Mendesain Pondasi Footplate 

dengan AutoCAD seperti gambar. 
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Gambar 1.6 Pondasi Footplate 

 

   1. Tentukan Ukuran Footplate dan Kolom 



 

30 

Misalnya: 

• Ukuran footplate: 1,2 m x 1,2 m 

• Tebal footplate: 0,3 m 

• Ukuran kolom: 0,2 m x 0,2 m 

• Tulangan pokok: Ø12-150 mm 

• Tulangan sengkang: Ø10-200 mm 

   2. Buka AutoCAD dan Buat Gambar Rencana  

(Plan View) 

a. Buat Footplate 

• Gunakan Command: RECTANGLE 

• Klik titik awal → ketik @1.2,1.2 → 

Enter 

o Ini membuat kotak 1,2 m x 1,2 m 

b. Buat Kolom di Tengah 

• Gunakan Command: RECTANGLE 

lagi 

• Klik titik tengah footplate → ketik 

@0.2,0.2 → Enter 

c. Gunakan Move dan OSNAP untuk 

memusatkan kolom ke footplate (pakai 

Midpoint dan Center) 

   3. Buat Tampak Potongan (Section View) 

a. Buat Kotak Vertikal 

• Gunakan RECTANGLE → gambar 

footplate secara vertikal: lebar 1.2m 

dan tinggi 0.3m 
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b. Tambahkan Kolom di Atas Footplate 

• Buat kotak ukuran 0.2 m x 0.2 m di atas 

footplate 

• Ketinggian kolom bisa disesuaikan (misal 

3 m) 

   4. Tambahkan Detail Tulangan 

• Gunakan CIRCLE untuk menggambar 

tulangan (besi Ø12 atau Ø10) 

• Sebar tulangan secara merata, gunakan 

ARRAY atau copy manual 

• Gunakan LINE dan DIM untuk membuat 

simbol dan ukuran penulangan 

• Tambahkan keterangan: jenis besi, 

jarak, dan cover beton 

• Contoh teks: 

Tulangan pokok Ø12-150 mm 

Sengkang Ø10-200 mm 

Tebal plat: 30 cm 

   5. Tambahkan Notasi dan Ukuran 

• Gunakan DIMLINEAR dan MTEXT 

untuk memberi ukuran dan catatan 

• Ukur tebal pondasi, jarak besi, ukuran 

kolom, dan lebar footplate 

   6. Tambahkan Hatching (Arsir) 

• Gunakan HATCH untuk menandai beton 

(pakai pola ANSI31) 
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• Arsirlah area potongan pondasi 

   7. Simpan dan Plot 

• Simpan file: File > Save As > .dwg 

• Untuk cetak: Layout → atur skala → Plot 

 

     Langkah-Langkah Mendesain Sloof dengan 

AutoCAD seperti gambar. 

 

Gambar 1.7 Sloof 

 

   1. Buka AutoCAD dan Buat Gambar Rencana 

(Plan View) 

a. Buat dinding atau kolom sebagai acuan 

• Gunakan RECTANGLE → gambar garis 

dinding (misalnya 3m panjang) 

b. Tambahkan lokasi sloof 
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• Gambar garis di bawah dinding → ini 

adalah sumbu sloof 

• Gunakan LINE atau RECTANGLE untuk 

menggambarnya secara simbolik 

   2. Gambar Potongan Sloof (Section View) 

a. Buat Balok Sloof 

• Gunakan RECTANGLE 

• Misal ukuran sloof: 15 cm (lebar) x 20 

cm (tinggi) 

• Ketik: RECTANGLE → klik → ketik 

@0.15,0.3 

b. Tambahkan Tulangan Pokok 

• Gunakan CIRCLE → buat lingkaran 

kecil Ø10 

• Tempatkan 3–4 lingkaran di atas dan 

bawah sloof (tulangan pokok) 

c. Tambahkan Sengkang (Stirrups) 

• Buat persegi dalam sloof (misalnya 

ukuran 10x15 cm, dengan cover beton 

2.5 cm) 

• Gunakan RECTANGLE atau 

POLYLINE 

   3. Tambahkan Dimensi dan Keterangan 

• Gunakan DIMLINEAR atau 

DIMALIGNED untuk memberi ukuran: 

o Panjang sloof 
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o Dimensi penampang 

o Jarak sengkang 

o Cover beton 

• Contoh teks: 

o Sloof 15/20 cm 

o Tulangan pokok: 4D10 

o Sengkang: Ø8-150 mm 

o Cover beton: 25 mm 

   4. Hatching dan Simbol Arsitektur 

• Gunakan HATCH untuk memberikan 

arsir beton (pakai ANSI31) 

• Tambahkan tanda panah potongan, notasi 

arah pandang, dan label A-A atau B-B 

   5. Gunakan Layer untuk Organisasi Gambar 

• Buat layer seperti: 

o Garis struktur 

o Tulangan 

o Dimensi 

o Teks 

o Arsir 

   6. Simpan, Atur Skala & Cetak 

• Simpan file .dwg 

• Atur skala gambar (misal 1:20) 

• Gunakan Layout dan Viewport untuk 

menyusun gambar kerja 

• Plot PDF untuk dicetak. 
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     Langkah-Langkah Mendesain Kolom di AutoCAD 

seperti gambar. 

 

Gambar 1.8 Kolom 



 

36 

  1. Siapkan Workspace AutoCAD 

• Gunakan satuan milimeter atau meter 

• Buat layer terpisah untuk: 

o Kolom 

o Tulangan 

o Teks 

o Dimensi 

o Arsir 

  2. Gambar Penampang Kolom 

Contoh: Kolom berukuran 30 cm x 30 cm 

a. Gunakan RECTANGLE 

• Command: RECTANGLE → klik 

titik awal → ketik @0.3,0.3 

• Atau: buat dengan LINE ukuran 300 

x 300 mm 

b. Tambahkan Tulangan Pokok 

Gunakan CIRCLE dengan radius 4–8 

mm, sesuai diameter tulangan. 

• Untuk tulangan Ø16 mm, gunakan 

radius = 0.008 

• Biasanya jumlah tulangan kolom: 

o 4D16 (untuk kolom kecil) 

o 6D16 atau lebih (untuk kolom 

besar) 
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Tempatkan tulangan di empat sudut 

dalam, beri jarak terhadap sisi luar (cover 

beton, biasanya 25–40 mm) 

  3. Tambahkan Sengkang (Stirrup) 

Gunakan OFFSET ke dalam dari kotak utama 

sebesar cover beton, lalu buat persegi dalam. 

Contoh: 

• Cover: 25 mm → ukuran stirrup dalam = 

0.25m x 0.25m 

• Gunakan POLYLINE atau RECTANGLE 

untuk menggambar 

• Tambahkan notasi sengkang seperti: 

Ø8-100 (jarak 100 mm, besi Ø8 mm) 

  4. Gambar Denah Posisi Kolom 

• Tampilkan posisi kolom terhadap grid 

bangunan 

• Gunakan CIRCLE atau BLOCK untuk 

simbol titik kolom 

• Tambahkan nama kolom (K1, K2, dst.) 

  5. Tambahkan Dimensi dan Keterangan 

Gunakan: 

• DIMLINEAR atau DIMALIGNED → 

untuk memberi ukuran panjang-lebar 

kolom 

• MTEXT → untuk memberi spesifikasi 

tulangan 
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• Contoh: 

Kolom 30/30 cm 

4D16 + Ø8-100 

Cover beton: 25 mm 

  6. Tambahkan Arsir 

• Gunakan HATCH → pilih pola ANSI31 

atau Solid untuk menunjukkan beton 

• Gunakan pola berbeda jika perlu bedakan 

elemen 

  7. Atur Skala dan Cetak 

• Masuk ke tab Layout 

• Atur skala viewport (misal 1:20) 

• Gunakan PLOT untuk menyimpan dalam 

format PDF atau mencetak langsung 

 

     Langkah-Langkah Mendesain Balok dengan 

AutoCAD seperti gambar. 

 

Gambar 1.9 Balok 
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  1. Buka AutoCAD dan Siapkan Workspace 

• Gunakan satuan meter atau milimeter, 

sesuai standar proyek. 

• Buat layer-layer: struktur, tulangan, teks, 

dimensi, arsir. 

  2. Gambar Potongan Balok 

Misalnya desain balok 20 cm lebar × 40 cm 

tinggi. 

a. Gambar bentuk balok 

• Gunakan perintah RECTANGLE → klik 

dua titik → ketik @0.2,0.4 untuk ukuran 

20x40 cm. 

b. Tambahkan sengkang (stirrup) 

• Gunakan OFFSET 0.025 (cover 2,5 cm) 

• Buat kotak dalam, lalu COPY ke 

sepanjang panjang balok jika diperlukan 

(pada rencana). 

c. Tambahkan tulangan pokok 

• Gunakan CIRCLE kecil (radius 2–4 mm 

sesuai Ø besi) 

• Tempatkan 2 batang atas dan 2 bawah, 

bisa lebih tergantung desain 

• Contoh: 4D16 → 4 batang tulangan Ø16 

mm 

  3. Gambar Rencana Balok 
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Jika ingin menggambar tampak atas (rencana): 

• Gunakan LINE untuk menunjukkan 

panjang balok (misal 4 m → @4,0) 

• Tambahkan titik-titik pertemuan dengan 

kolom 

• Tandai posisi sengkang (jarak antar 

stirrup bisa digambarkan simbolis) 

  4. Tambahkan Dimensi dan Notasi 

• Gunakan perintah DIMLINEAR, 

DIMALIGNED, dan MTEXT untuk 

memberi: 

o Ukuran balok (tinggi, lebar) 

o Spesifikasi tulangan dan sengkang 

o Cover beton 

• Contoh tulisan: 

o Balok 20/40 cm 

o Tulangan pokok: 4D16 (2 atas, 2 

bawah) 

o Sengkang: Ø8-150 mm 

o Cover: 25 mm 

  5. Tambahkan Hatch (Arsir) 

• Gunakan HATCH → pilih pola ANSI31 

atau Solid 

• Beri arsir pada beton atau bagian 

potongan untuk membedakan material 

  6. Atur Skala & Tata Letak 
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• Gunakan Layout tab untuk membuat 

viewport 

• Atur skala gambar (misal 1:20) 

• Tambahkan judul, keterangan gambar, 

dan tanda potongan 

  7. Cetak atau Ekspor 

• Gunakan PLOT untuk menyimpan 

sebagai PDF atau langsung cetak 

• Pastikan layer dan warna sesuai standard 

plotting. 

 

     Langkah-langkah Mendesain Atap di AutoCAD 

seperti Gambar 

 

Gambar 1.10 Atap 

 

  1. Buat Rencana Atap (Roof Plan) 

a. Tentukan bentuk atap 

Contoh: Atap limas, pelana, atau 

kombinasi. 

b. Gunakan LINE dan POLYLINE 
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• Gambar outline bangunan (misal: 

persegi 6x10 m). 

• Tentukan titik puncak atap (nok). 

• Gambar garis kemiringan dari ujung 

ke nok. 

• Gunakan OFFSET jika ingin 

menggambar overstek (misal: 50 cm 

keluar dari dinding). 

c. Tambahkan garis talang dan aliran air 

hujan 

• Gunakan DASHED LINE untuk 

menunjukkan talang dalam. 

  2. Gambar Potongan Atap 

a. Tentukan kemiringan atap 

• Gunakan rasio umum: 30° 

(kemiringan 1:3) atau 35°. 

b. Gambar rangka kuda-kuda 

• Gunakan LINE dan TRIM untuk 

membentuk segitiga. 

• Tambahkan elemen: 

o Top chord (atas) 

o Bottom chord (bawah) 

o Web (pengisi diagonal atau 

vertikal) 

c. Tambahkan material: 

• Reng dan usuk 
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• Genteng (diwakili oleh garis dan 

arsir) 

  3. Detail Rangka Kuda-Kuda 

• Gunakan DIMLINEAR dan MTEXT 

untuk memberi ukuran dan 

keterangan: 

o Jenis bahan (baja ringan C75.75, 

kayu 5/10) 

o Panjang bentang (span) 

o Tinggi nok 

• Contoh teks: 

o rangka atap baja ringan C75.75 

@600 mm 

o Genteng keramik, berat 45 kg/m² 

o Kemiringan 35° 

o Overstek 50 cm 

  4. Gunakan Layer Terpisah 

• Atap: Warna merah 

• Rangka: Biru 

• Notasi dan dimensi: Hitam 

• Gunakan HATCH untuk arsir genteng 

(pola: ANSI37, SOLID, dll.) 

  5. Tambahkan Judul dan Skala 

• Buat kotak judul di Layout 

• Atur viewport AutoCAD ke skala 1:50 

atau 1:100 
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• Pastikan semua ukuran dan notasi terbaca 

           Contoh Spesifikasi Atap 

• Model atap: Atap pelana 

• Bentang: 6 m 

• Kemiringan: 35° 

• Bahan rangka: Baja ringan C75.75 

• Penutup atap: Genteng beton flat 

• Overstek: 50 cm 

 

 

3. Ekspor dan Integrasi ke BIM Platform 

a. Model dari SketchUp dan AutoCAD diekspor ke format 

.DWG untuk diupload mahasiswa ke dalam aplikasi. 

Mahasiswa melakukan register dan login ke dalam 

aplikasi sebagai mahasiswa. Aplikasi dapat diakses 

melalui laman https://bimsimulation.com. 

 

Gambar 1.11 Pengembangan Aplikasi BIM 
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4. Penggabungan Data Multidisiplin 

a. Informasi struktur, arsitektur diintegrasikan ke dalam 

satu model koordinasi. 

b. Tim lintas bidang bekerja dalam satu file proyek. 

 

Gambar 1.12 Penggabungan Data Multidisiplin 

 

5. Koordinasi Akhir dan Clash Detection 

a. Software BIM melakukan deteksi benturan antar elemen 

bangunan. 

b. Revisi dilakukan sebelum proyek masuk ke tahap 

konstruksi. 
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BAB III 

PENGAPLIKASIAN BIM 4D 

 

3.1.  CAPAIAN PEMBELAJARAN 

1. Mahasiswa dapat menjelaskan konsep dasar BIM 4D 

sebagai integrasi model 3D dengan dimensi waktu 

(time/scheduling) dalam proyek konstruksi. 

2. Mahasiswa dapat mengidentifikasi elemen-elemen dalam 

model BIM yang relevan dengan perencanaan waktu 

pelaksanaan proyek. 

3. Mahasiswa dapat menghubungkan elemen model 3D 

dengan aktivitas dalam jadwal proyek menggunakan 

perangkat lunak BIM 4D. 

4. Mahasiswa dapat menganalisis simulasi jadwal konstruksi 

berbasis visual untuk mengidentifikasi potensi konflik dan 

kemacetan. 

5. Mahasiswa dapat menggunakan BIM 4D untuk menyusun, 

mengevaluasi, dan memperbarui time schedule proyek 

secara lebih efektif dan akurat. 

6. Mahasiswa dapat menginterpretasikan hasil visualisasi 4D 

sebagai dasar pengambilan keputusan dalam pengelolaan 

waktu proyek. 

 

3.2.  TIME/SCHEDULING (BIM 4D) 

BIM 4D adalah penggabungan model tiga dimensi (3D) dengan 

dimensi keempat, yaitu waktu (time/scheduling). Dalam konteks ini, 
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BIM 4D memungkinkan pengguna untuk mengintegrasikan elemen 

waktu ke dalam model proyek konstruksi, sehingga seluruh proses 

pembangunan dapat divisualisasikan secara lebih dinamis dan realistis. 

Tujuan utama BIM 4D adalah memberikan pemahaman yang lebih baik 

terhadap urutan kegiatan konstruksi, durasi pekerjaan, dan keterkaitan 

antar tugas dalam jadwal proyek. 

Dengan penerapan BIM 4D, pihak manajemen proyek dapat 

menyusun jadwal pembangunan secara lebih akurat dan efisien. Model 

BIM yang telah dibuat dalam format 3D kemudian dihubungkan 

dengan jadwal proyek (misalnya dari Primavera atau Microsoft 

Project), sehingga setiap elemen fisik bangunan memiliki kaitan 

langsung dengan aktivitas konstruksi yang relevan dalam time 

schedule. Hal ini memberikan gambaran visual bagaimana proyek akan 

dibangun dari waktu ke waktu. 

Salah satu keunggulan utama BIM 4D adalah kemampuannya 

untuk melakukan simulasi proses konstruksi. Tim proyek dapat melihat 

animasi atau visualisasi urutan pembangunan dalam bentuk grafik 

waktu nyata. Ini sangat membantu dalam memahami potensi konflik 

jadwal, mengidentifikasi kemacetan proses, dan mengoptimalkan 

pengalokasian sumber daya. Visualisasi ini juga memudahkan semua 

pihak mulai dari kontraktor hingga pemilik proyek dalam memahami 

alur pelaksanaan. 

BIM 4D sangat berguna dalam tahap perencanaan karena dapat 

membantu merencanakan aktivitas dengan lebih efisien. Dengan 

informasi visual, penjadwalan dapat dilakukan berdasarkan urutan 

konstruksi yang logis, bukan hanya berdasarkan estimasi atau standar 

umum. Penjadwalan ini memperhitungkan kondisi riil lapangan seperti 
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ketersediaan ruang kerja, interaksi antar pekerjaan, dan aksesibilitas 

lokasi kerja. 

Dalam tahap pelaksanaan, BIM 4D juga memberikan manfaat 

besar. Model 4D dapat digunakan untuk memantau progres proyek 

secara visual. Tim lapangan dapat membandingkan kondisi aktual 

dengan jadwal yang telah direncanakan dan segera mengidentifikasi 

keterlambatan atau deviasi. Informasi ini mendukung pengambilan 

keputusan yang cepat dan berbasis data dalam hal perbaikan jadwal dan 

pengendalian proyek. 

Penerapan BIM 4D mendukung kolaborasi lintas disiplin. Dengan 

model yang dapat diakses oleh berbagai pihak, termasuk arsitek, 

insinyur, manajer proyek, dan kontraktor, koordinasi pekerjaan menjadi 

lebih efektif. Jadwal yang ditautkan dengan model fisik bangunan 

mendorong pemahaman yang seragam dan mengurangi potensi 

kesalahan komunikasi antar tim. 

BIM 4D juga membantu dalam mengelola risiko proyek. Dengan 

simulasi waktu, potensi konflik pekerjaan, penumpukan kegiatan, dan 

kesalahan penjadwalan dapat dideteksi sejak awal. Misalnya, dua 

pekerjaan yang seharusnya tidak berlangsung bersamaan karena 

berbagi ruang kerja yang sama dapat teridentifikasi dan dijadwalkan 

ulang sebelum proyek dimulai. 

Dalam proyek skala besar, seperti gedung bertingkat tinggi atau 

infrastruktur publik, BIM 4D sangat penting dalam mengelola ribuan 

aktivitas yang saling berkaitan. Visualisasi jadwal secara bertahap 

memungkinkan manajemen untuk fokus pada tahapan-tahapan kritis 

proyek dan memastikan bahwa jalur kritis (critical path) tidak 

terganggu, sehingga keseluruhan proyek dapat selesai tepat waktu. 
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BIM 4D juga menjadi alat komunikasi yang efektif dengan 

pemangku kepentingan. Pemilik proyek, investor, atau pihak 

pemerintahan dapat melihat representasi visual bagaimana proyek akan 

berlangsung dan kapan tiap bagian akan selesai. Hal ini meningkatkan 

transparansi dan kepercayaan terhadap proses pelaksanaan proyek. 

Secara keseluruhan, penerapan BIM 4D dalam aspek 

time/scheduling memberikan nilai tambah signifikan dalam manajemen 

proyek konstruksi. Selain meningkatkan efisiensi dan akurasi jadwal, 

BIM 4D juga meningkatkan kolaborasi tim, mengurangi risiko 

keterlambatan, dan membantu proses pengambilan keputusan yang 

lebih tepat. Dalam era digitalisasi konstruksi, penggunaan BIM 4D 

menjadi semakin penting untuk mendukung pelaksanaan proyek yang 

lebih terintegrasi dan berkelanjutan. 

 

3.3.  ALUR KERJA (WORKFLOW) BIM 4D 

1. Persiapan Model BIM 3D 

Langkah pertama dan sangat krusial dalam penerapan 

BIM 4D adalah memastikan ketersediaan model BIM 3D 

yang lengkap, akurat, dan sesuai standar. Model ini dapat 

dibangun secara internal oleh tim proyek atau diperoleh dari 

konsultan perencana. Model BIM 3D harus mencakup 

seluruh elemen bangunan termasuk struktur utama (seperti 

balok, kolom, dan pelat), elemen arsitektural (dinding, pintu, 

jendela, atap), serta sistem MEP (Mechanical, Electrical, dan 

Plumbing). 

Informasi non-geometrik yang menyertainya juga tidak 

kalah penting, seperti jenis material, volume material, lokasi 
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pemasangan, dan informasi relevan lainnya. Semakin detail 

dan informatif model 3D, semakin akurat proses integrasi 

dengan jadwal di tahap selanjutnya. Oleh karena itu, validasi 

awal model BIM 3D untuk kelengkapan data sangat 

disarankan agar tidak terjadi kesalahan saat menghubungkan 

dengan elemen penjadwalan konstruksi. 

Selain itu, model harus mengikuti standar BIM 

nasional atau internasional seperti ISO 19650, yang 

mencakup naming convention, struktur folder, dan parameter 

informasi objek. Hal ini penting untuk memudahkan integrasi 

antar software serta kolaborasi lintas disiplin dalam proyek. 

Perangkat lunak yang umum digunakan untuk membangun 

model BIM 3D antara lain Autodesk Revit, ArchiCAD. 

 

2. Penyusunan Jadwal Proyek (Scheduling) 

Penyusunan jadwal proyek dilakukan secara paralel 

dengan pengembangan model 3D. Tujuannya adalah 

menyusun time schedule proyek secara menyeluruh, mulai 

dari tahap awal mobilisasi hingga penyelesaian akhir proyek. 

Jadwal ini menjadi pondasi utama dalam sistem BIM 4D 

karena seluruh aktivitas konstruksi nantinya akan 

dihubungkan ke model 3D. 
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Gambar 3.1 Scheduling 

 

Software penjadwalan seperti Excel, Primavera P6, 

Microsoft Project, atau Asta Powerproject digunakan untuk 

mengidentifikasi seluruh aktivitas, durasi, relasi antar 

aktivitas (dependency), serta jalur kritis (critical path). 

Jadwal yang baik harus bersifat realistis dan 

mempertimbangkan aspek teknis, sumber daya manusia, 

peralatan, serta faktor eksternal seperti cuaca atau perizinan. 

Setiap aktivitas dalam jadwal perlu diberikan kode unik 

atau ID aktivitas. ID ini akan digunakan sebagai tautan antara 

elemen konstruksi dalam model BIM 3D dengan aktivitas 

pekerjaan pada timeline proyek. Kesalahan dalam 

penomoran atau penyusunan aktivitas dapat menghambat 

proses linking dan menimbulkan kebingungan saat 

visualisasi simulasi. 

3. Integrasi Model 3D dan Jadwal (Linking Activities) 

Tahapan ini merupakan inti dari penerapan BIM 4D. 

Setelah model 3D dan jadwal proyek tersedia, langkah 
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selanjutnya adalah mengaitkan (linking) elemen model BIM 

3D dengan aktivitas dalam time schedule. Proses ini 

dilakukan dengan menggunakan software BIM 4D seperti 

Autodesk Navisworks, Synchro 4D, atau Bentley 

OpenBuildings Designer. 

Setiap elemen dalam model seperti balok, kolom, 

dinding, dan plat lantai harus dihubungkan dengan aktivitas 

yang sesuai dalam jadwal konstruksi. Misalnya, elemen 

kolom lantai 1 dikaitkan dengan aktivitas "Pemasangan 

Kolom Lantai 1." Proses linking dapat dilakukan secara 

manual atau otomatis, tergantung pada perangkat lunak dan 

struktur data yang digunakan. 

Penting untuk memastikan bahwa setiap elemen hanya 

dikaitkan dengan aktivitas yang relevan dan tidak terjadi 

duplikasi atau kekosongan link. Ketelitian dalam proses ini 

sangat berpengaruh terhadap keakuratan visualisasi 

konstruksi dalam simulasi waktu. Dalam proyek berskala 

besar, struktur pembagian zona atau work package sangat 

membantu dalam memudahkan proses linking. 

 

4. Simulasi dan Visualisasi Jadwal Konstruksi 

Setelah proses linking selesai, software BIM 4D akan 

menjalankan simulasi waktu berdasarkan urutan aktivitas 

dalam jadwal. Simulasi ini akan memperlihatkan bagaimana 

elemen-elemen konstruksi dipasang dari waktu ke waktu. 

Dalam tampilan 4D, pengguna dapat melihat progres 
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pembangunan secara visual mulai dari awal hingga selesai 

proyek. 

Visualisasi ini sangat membantu dalam 

mengidentifikasi konflik, seperti pekerjaan yang saling 

tumpang tindih, area kerja yang padat, atau pengangkutan 

material yang bersinggungan. Hal-hal tersebut seringkali 

tidak terlihat dalam penjadwalan konvensional berbasis tabel 

atau Gantt chart. Simulasi juga dapat digunakan sebagai alat 

bantu komunikasi untuk menjelaskan tahapan proyek kepada 

stakeholder yang non-teknis. 

BIM 4D memungkinkan tim proyek untuk 

mengevaluasi efisiensi urutan kerja, mengantisipasi risiko 

keterlambatan, serta menyesuaikan strategi pelaksanaan jika 

diperlukan. Hal ini sangat penting terutama untuk proyek-

proyek besar yang memiliki banyak aktivitas dan 

ketergantungan antar pekerjaan. 

5. Review dan Integrasi ke BIM Platform melalui Aplikasi  

Tahapan review dilakukan setelah simulasi visual 4D 

selesai dijalankan. Tim proyek dari berbagai disiplin 

berkumpul untuk melakukan validasi terhadap urutan 

pekerjaan, ketersediaan ruang kerja, dan potensi masalah 

koordinasi antar tim pelaksana. Diskusi ini mencakup aspek 

teknis, manajerial, dan keselamatan kerja di lapangan. 

Review ini memungkinkan pengguna mendeteksi 

apakah ada aktivitas yang terlalu padat, pekerjaan yang 

seharusnya dilakukan bertahap namun direncanakan 

serentak, atau keterlambatan yang tidak realistis. Kadang-
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kadang, perbedaan logika antar disiplinmisalnya antara 

arsitektur dan struktur baru terlihat saat visualisasi 

dijalankan. 

Hasil dari proses review ini biasanya menghasilkan 

revisi terhadap model BIM, jadwal konstruksi, atau bahkan 

metode pelaksanaan. Dengan kata lain, review dan validasi 

merupakan bagian penting dari proses iteratif dalam 

menyempurnakan integrasi antara rencana dan kenyataan 

proyek. 

6. Optimalisasi Jadwal Konstruksi 

Setelah menemukan kelemahan atau konflik pada 

jadwal yang divisualisasikan, langkah selanjutnya adalah 

mengoptimalkan urutan dan alokasi aktivitas konstruksi. 

Optimalisasi ini mencakup penyesuaian urutan kerja agar 

lebih efisien, pengelompokan aktivitas dengan zona kerja 

yang sama, atau penghindaran dari benturan ruang kerja 

antar tim. 

Misalnya, jika ditemukan bahwa pemasangan ducting 

HVAC berpotensi terganggu oleh pekerjaan balok lantai, 

maka aktivitas tersebut dapat dipindahkan ke waktu yang 

lebih sesuai. Optimalisasi juga mencakup penyesuaian waktu 

pengiriman material, mobilisasi alat berat, dan sinkronisasi 

antar subkontraktor. 

Langkah ini biasanya dilakukan beberapa kali (iteratif) 

hingga diperoleh jadwal yang optimal baik dari segi waktu, 

biaya, dan sumber daya. Proses ini merupakan keunggulan 
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dari pendekatan BIM 4D karena memberikan pendekatan 

visual yang dinamis terhadap optimalisasi. 

6. Koordinasi Akhir dan Clash Detection melalui Aplikasi  

Model BIM 4D yang sudah disempurnakan harus 

dipublikasikan ke seluruh pemangku kepentingan proyek. Ini 

mencakup kontraktor utama, subkontraktor, konsultan 

pengawas, dan pemilik proyek. Publikasi dapat dilakukan 

dalam bentuk file digital, cloud platform (seperti Autodesk 

Construction Cloud atau Trimble Connect), atau ditampilkan 

langsung dalam rapat koordinasi. 

Model 4D ini menjadi acuan bersama dalam pertemuan 

mingguan atau bulanan untuk memonitor progres, membahas 

potensi kendala, dan menyamakan persepsi antar pihak. 

Penggunaan model visual sangat membantu memperjelas 

rencana kerja harian atau mingguan yang akan dilaksanakan. 

Koordinasi lintas tim menjadi lebih efektif karena 

semua pihak melihat representasi visual yang sama dan 

bukan sekadar membaca dokumen teks atau diagram statis. 

Ini dapat mencegah miskomunikasi dan meningkatkan 

akurasi pelaksanaan proyek di lapangan. 

7. Monitoring Progres Proyek 

Setelah proyek berjalan, model BIM 4D terus 

diperbarui dengan data dari lapangan. Progres aktual 

dibandingkan dengan rencana yang telah disusun untuk 

melihat apakah proyek berjalan sesuai jadwal atau terjadi 

deviasi. Data ini dapat dimasukkan ke dalam software 4D 

secara berkala oleh tim monitoring atau field engineer. 
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Hasil pembaruan ini memungkinkan dilakukan analisis 

nilai hasil (earned value analysis), yaitu membandingkan 

antara nilai pekerjaan yang telah diselesaikan dengan waktu 

dan biaya yang dikeluarkan. Selain itu, model ini dapat 

menjadi dasar dalam pelaporan mingguan atau bulanan 

kepada manajemen dan pemilik proyek. 

Dengan adanya sistem monitoring berbasis BIM 4D, 

pengambilan keputusan menjadi lebih cepat, berbasis data, 

dan transparan. Tim dapat segera mengambil tindakan 

korektif jika ditemukan keterlambatan atau masalah di 

lapangan. 
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BAB IV 

PENGAPLIKASIAN BIM 5D 

 

4.1.  CAPAIAN PEMBELAJARAN 

1. Mahasiswa mampu menjelaskan konsep dasar BIM 5D 

sebagai integrasi model 3D dan estimasi biaya proyek 

konstruksi. 

2. Mahasiswa mampu mengidentifikasi elemen-elemen model 

BIM yang dapat digunakan untuk perhitungan kuantitas dan 

biaya. 

3. Mahasiswa mampu menggunakan perangkat lunak BIM untuk 

melakukan estimasi biaya berdasarkan data kuantitas dari 

model. 

4. Mahasiswa mampu menganalisis dampak perubahan desain 

terhadap estimasi biaya proyek secara dinamis. 

5. Mahasiswa mampu menyusun Rencana Anggaran Biaya 

(RAB) yang terintegrasi dengan model BIM secara efisien 

dan akurat 

 

4.2.  ESTIMASI BIAYA (BIM 5D) 

BIM 5D adalah pengembangan dari BIM 4D dengan 

menambahkan dimensi kelima, yaitu estimasi biaya (cost estimation). 

BIM 5D memungkinkan integrasi antara model 3D, jadwal proyek 

(4D), dan informasi biaya, sehingga seluruh elemen konstruksi tidak 

hanya memiliki bentuk fisik dan waktu pelaksanaan, tetapi juga nilai 

ekonominya. Tujuan utama BIM 5D adalah memberikan estimasi biaya 
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yang lebih akurat, transparan, dan dinamis sepanjang siklus hidup 

proyek. 

Penerapan BIM 5D dimulai dari pemodelan elemen bangunan 

secara detail dalam BIM 3D, yang dilengkapi dengan informasi 

kuantitas seperti volume, panjang, luas, dan jumlah unit dari setiap 

komponen. Data kuantitatif ini secara otomatis dihitung dari model 

digital dan menjadi dasar utama dalam melakukan perhitungan biaya. 

Ini mengurangi ketergantungan pada metode manual dalam pembuatan 

Bill of Quantity (BoQ). 

Selanjutnya, data kuantitas dari model BIM dihubungkan dengan 

informasi harga satuan material, tenaga kerja, dan peralatan yang sesuai 

dengan standar atau database biaya proyek. Proses ini bisa dilakukan 

dengan bantuan software BIM 5D seperti CostX, Vico Office, atau 

Navisworks Quantification, yang mendukung integrasi otomatis antara 

model dan sistem estimasi biaya. 

Salah satu keunggulan utama BIM 5D adalah kemampuannya 

dalam melakukan estimasi biaya secara real-time. Setiap perubahan 

desain pada model akan secara langsung memengaruhi nilai biaya 

proyek yang ditampilkan. Ini memberikan fleksibilitas tinggi bagi tim 

perencana dan pemilik proyek untuk mengevaluasi alternatif desain 

tanpa perlu menyusun ulang seluruh perhitungan biaya dari awal. 

BIM 5D juga sangat mendukung dalam proses value engineering. 

Dengan transparansi antara desain dan biaya, tim proyek dapat 

membandingkan beberapa opsi desain berdasarkan efisiensi biaya. 

Misalnya, mengganti jenis material, mengubah ukuran elemen struktur, 

atau menyederhanakan desain, dan langsung melihat dampaknya 

terhadap total anggaran proyek. 
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Dalam tahap perencanaan anggaran (budget planning), BIM 5D 

memungkinkan penyusunan proyeksi anggaran yang lebih akurat dan 

realistis. Perhitungan biaya berdasarkan data digital mengurangi risiko 

kesalahan akibat asumsi atau estimasi manual yang tidak akurat. Hal ini 

memberikan keyakinan lebih besar kepada investor dan pemilik proyek 

dalam mengelola keuangan proyek sejak awal. 

Selama tahap pelaksanaan, BIM 5D digunakan untuk memantau 

penggunaan biaya secara progresif. Dengan membandingkan rencana 

biaya (planned cost) dengan biaya aktual (actual cost), tim proyek 

dapat melakukan evaluasi secara berkala. Ini sangat membantu dalam 

mengendalikan pengeluaran proyek, mencegah pemborosan, dan 

mengambil keputusan korektif lebih cepat. 

Penerapan BIM 5D juga meningkatkan kolaborasi antar tim, 

terutama antara estimator, quantity surveyor, arsitek, dan manajemen 

proyek. Semua pihak dapat melihat informasi biaya yang berasal dari 

satu sumber data yang sama (single source of truth), sehingga 

meminimalkan konflik atau interpretasi berbeda terhadap angka 

estimasi. 

BIM 5D mendukung penerapan transparansi dan akuntabilitas 

dalam proyek. Pemilik proyek dapat memantau biaya secara detail dan 

memahami penyebab naik turunnya anggaran. Di sisi lain, kontraktor 

bisa merinci dengan jelas struktur harga yang diajukan, sehingga 

menghindari potensi klaim atau perselisihan biaya di kemudian hari. 

Secara keseluruhan, BIM 5D membawa revolusi dalam 

manajemen biaya proyek konstruksi. Estimasi biaya menjadi lebih 

cepat, tepat, dan responsif terhadap perubahan. Dengan 

menggabungkan visualisasi, kuantitas, waktu, dan biaya dalam satu 
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platform terpadu, BIM 5D memperkuat efisiensi, produktivitas, dan 

keberlanjutan proyek dari awal hingga akhir. 

 

4.3.  ALUR KERJA (WORKFLOW) BIM 5D 

1. Pembuatan Model BIM 3D 

Tahapan pertama dalam alur kerja BIM 5D adalah 

membangun model digital tiga dimensi yang representatif 

terhadap kondisi aktual bangunan. Model ini harus mencakup 

semua elemen konstruksi secara menyeluruh, baik dari segi 

struktur, arsitektur, maupun sistem mekanikal, elektrikal, dan 

perpipaan (MEP). Pemodelan dilakukan menggunakan 

software seperti Autodesk Revit, ArchiCAD, atau Allplan 

yang memungkinkan input informasi yang kaya pada tiap 

elemen bangunan. 

Setiap komponen dalam model, seperti kolom, balok, 

dinding, lantai, dan sistem pipa, wajib dilengkapi dengan 

data teknis seperti jenis material, volume, luas permukaan, 

dan dimensi geometris lainnya. Informasi ini sangat penting 

karena akan digunakan untuk menghitung kuantitas 

pekerjaan secara otomatis dan akurat pada tahap selanjutnya. 

Model 3D bukan hanya visualisasi, tetapi juga menjadi 

basis data terintegrasi (data-rich model) yang dapat 

dimanfaatkan untuk berbagai keperluan analisis biaya, 

manajemen proyek, dan pengambilan keputusan. Oleh karena 

itu, konsistensi dan kualitas data dalam model menjadi 

perhatian utama pada tahap ini. 
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Gambar 4.1 Gambar Struktural dan Arsitektural 
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2. Penghitungan Kuantitas Otomatis (Quantity Takeoff) 

Setelah model 3D selesai dan divalidasi, langkah 

berikutnya adalah melakukan penghitungan kuantitas atau 

quantity takeoff secara otomatis. Proses ini memungkinkan 

sistem menghitung semua volume dan jumlah dari elemen-

elemen bangunan berdasarkan informasi yang tertanam di 

dalam model. Misalnya, sistem dapat menghitung total 

volume beton, panjang pipa, jumlah jendela, atau luas area 

finishing secara instan. 

 

Gambar 4.2 Gambar Perhitungan Total Volume Septik Tank 

 

Berbeda dari metode tradisional yang memerlukan 

perhitungan manual dari gambar 2D, metode BIM 
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memungkinkan perhitungan yang jauh lebih cepat, presisi, 

dan mudah diperbarui. Software yang sering digunakan 

antara lain Autodesk Navisworks (Quantification Tool), 

CostX, Cubit, atau Revit Schedule. 

Proses ini bukan hanya menghemat waktu, tetapi juga 

meminimalisir kesalahan akibat human error. Hasil 

perhitungan kuantitas ini kemudian dapat diekspor menjadi 

laporan atau langsung diintegrasikan dengan basis data harga 

untuk estimasi biaya proyek. 

 

3. Integrasi dengan Data Harga (Cost Database) 

Tahap selanjutnya adalah mengaitkan kuantitas hasil 

takeoff dengan harga satuan pekerjaan yang valid. Proses ini 

memerlukan database harga yang dapat berasal dari berbagai 

sumber: standar nasional seperti HSPK dan SNI, data historis 

proyek sebelumnya, atau daftar harga lokal dari supplier dan 

kontraktor. 

Setiap item pekerjaan dalam model akan dihubungkan 

dengan satuan harga yang relevan. Misalnya, volume beton 

dikalikan dengan harga per m³, atau jumlah lampu dengan 

harga per unit. Proses ini menghasilkan perhitungan biaya 

yang lebih kontekstual dan mencerminkan kondisi pasar saat 

ini. 

Keterhubungan antara elemen model, kuantitas, dan 

harga memungkinkan terciptanya Bill of Quantity (BoQ) 

yang dinamis, di mana setiap perubahan pada model akan 

secara otomatis memperbarui nilai total biaya. Ini 
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menjadikan model BIM sebagai alat kalkulasi yang hidup 

dan responsif terhadap perubahan desain atau parameter 

proyek. 

 

4. Penyusunan Estimasi Biaya (Cost Estimation) 

Dengan kuantitas dan harga yang sudah terintegrasi, 

sistem BIM 5D akan menghitung estimasi biaya proyek 

secara menyeluruh. Estimasi ini meliputi biaya langsung 

seperti material, tenaga kerja, dan peralatan, serta biaya tidak 

langsung seperti manajemen proyek, asuransi, cadangan 

risiko, dan overhead lainnya. 

Keunggulan utama BIM 5D adalah kemampuannya 

menghasilkan estimasi biaya yang transparan, rinci, dan 

mudah ditelusuri. Setiap nilai yang muncul dalam estimasi 

dapat dilacak kembali ke elemen model, kuantitas, dan 

referensi harga yang digunakan. Ini memudahkan proses 

audit dan validasi internal. 

Estimasi biaya ini juga dapat disesuaikan dengan level 

detail model, mulai dari estimasi awal untuk feasibility study 

hingga estimasi mendetail untuk kebutuhan tender atau 

pelaksanaan proyek. Data biaya disajikan dalam bentuk 

laporan dan juga dapat ditampilkan secara interaktif dalam 

model. 

 

 

 

5. Visualisasi Biaya dalam Model 
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Salah satu keunggulan BIM 5D adalah kemampuannya 

menampilkan informasi biaya dalam bentuk visualisasi 

spasial. Artinya, biaya proyek tidak hanya disajikan dalam 

bentuk angka, tetapi juga divisualisasikan langsung pada 

elemen model. 

Contohnya, elemen dengan nilai biaya tertinggi seperti 

struktur utama dapat diberi warna merah, sementara elemen 

minor seperti railing diberi warna biru. Selain itu, biaya juga 

bisa ditampilkan per zona, per lantai, atau per paket 

pekerjaan. Ini memberikan wawasan visual kepada tim 

manajemen proyek untuk memahami bagaimana biaya 

tersebar di seluruh proyek. 

Visualisasi ini sangat membantu saat proses presentasi 

kepada pemilik proyek atau dalam forum koordinasi, karena 

lebih intuitif dan mudah dipahami oleh orang non-teknis 

sekalipun. 

6. Evaluasi Alternatif Desain (Value Engineering) 

Dengan data biaya yang real-time dan berbasis model, 

tim proyek dapat melakukan value engineering dengan lebih 

efisien. Misalnya, mengganti material penutup lantai dari 

granit ke keramik dapat segera divisualisasikan dampaknya 

terhadap biaya total proyek, tanpa harus menghitung ulang 

secara manual. 

Alternatif desain lainnya seperti perubahan ukuran 

komponen struktur, penyederhanaan fasad, atau substitusi 

peralatan MEP juga dapat dievaluasi secara cepat. Hasil 

analisis biaya langsung ditampilkan dalam model dan 
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laporan, sehingga proses pengambilan keputusan menjadi 

lebih berbasis data dan transparan. 

Evaluasi alternatif ini penting untuk mencapai efisiensi 

biaya tanpa mengorbankan kualitas dan fungsionalitas 

proyek. 

7. Penyusunan Rencana Anggaran Proyek (Budget 

Planning) 

Berdasarkan hasil estimasi biaya, tim keuangan dan 

manajemen proyek dapat menyusun Rencana Anggaran 

Biaya (RAB) secara komprehensif. RAB ini dapat 

diklasifikasikan berdasarkan jenis pekerjaan, subkontraktor, 

tahapan pelaksanaan, atau sistem bangunan. 

Jika BIM 5D dikombinasikan dengan BIM 4D 

(penjadwalan), maka perencanaan anggaran bisa dikaitkan 

dengan waktu pelaksanaan sehingga memungkinkan dibuat 

cash flow forecasting. Ini sangat bermanfaat untuk mengatur 

alokasi dana secara bertahap, mengatur pembayaran ke 

vendor, dan merencanakan pembiayaan proyek secara 

strategis. 

Selain itu, penggabungan jadwal dan anggaran 

mendukung sistem kontrol biaya yang lebih dinamis dan 

berbasis waktu, bukan hanya berbasis volume pekerjaan. 

 

8. Monitoring dan Pengendalian Biaya melalui Aplikasi  

Selama pelaksanaan proyek, model BIM 5D terus 

diperbarui sesuai perkembangan di lapangan. Aktivitas 

pemasangan elemen bangunan dicatat dalam sistem, dan 
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estimasi biaya aktual dihitung berdasarkan progres yang 

telah dicapai. Hal ini memungkinkan tim proyek melakukan 

perbandingan antara rencana biaya dan aktual (planned vs 

actual). 

Analisis ini sangat penting dalam manajemen proyek 

karena membantu mendeteksi penyimpangan anggaran (cost 

overrun) lebih awal. Selain itu, sistem juga mendukung 

pembuatan laporan pengeluaran per minggu atau per bulan 

secara otomatis berdasarkan progres lapangan. 

 

Gambar 4.3 Monitoring dan Pengendalian Biaya melalui 

Aplikasi 

Monitoring berbasis aplikasi seperti ini menjadikan 

manajemen biaya proyek lebih presisi, akuntabel, dan mudah 

diaudit kapan pun dibutuhkan. 

 

9. Revisi Estimasi Bila Ada Perubahan Desain 

Dalam kenyataan proyek, perubahan desain tidak bisa 

dihindari. Keunggulan BIM 5D adalah kemampuannya untuk 
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mengakomodasi perubahan secara cepat dan efisien. Ketika 

model 3D diperbarui karena adanya revisi desain, maka 

seluruh sistem BIM 5D akan secara otomatis memperbarui 

kuantitas dan estimasi biaya terkait. 

Hal ini menghindarkan kebutuhan untuk membuat 

RAB dari awal setiap kali ada perubahan desain. Revisi biaya 

cukup dilakukan dengan menyesuaikan model, lalu sistem 

akan menghitung ulang berdasarkan data terbaru. Proses ini 

mempercepat workflow dan mengurangi risiko perbedaan 

data antara perencana dan pelaksana. 

 

10. Dokumentasi dan Laporan Akhir 

Setelah proyek selesai, semua data yang telah 

dikumpulkan selama proses estimasi dan pelaksanaan dapat 

dikompilasi menjadi as-built cost model. Model ini 

merepresentasikan semua elemen yang benar-benar 

terpasang, beserta informasi biaya aktualnya. 

Dokumentasi akhir ini sangat berguna tidak hanya 

untuk keperluan audit dan pelaporan proyek, tetapi juga 

untuk manajemen fasilitas (facility management) jangka 

panjang. Informasi biaya yang tertanam dalam model dapat 

digunakan untuk merencanakan pemeliharaan, penggantian, 

atau renovasi di masa depan. 

Dengan demikian, BIM 5D tidak hanya memberikan 

manfaat saat perencanaan dan pelaksanaan, tetapi juga 

mendukung keberlanjutan pengelolaan bangunan secara 

menyeluruh. 
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GLOSARIUM 

BIM (Building Information Modeling) 

Teknologi berbasis digital yang digunakan untuk membuat, mengelola, 

dan memvisualisasikan informasi bangunan dalam bentuk model 3D 

yang terintegrasi dengan data teknis. 

 

Simulation 

Proses peniruan kondisi nyata dalam bentuk model digital untuk 

memahami, menganalisis, dan memprediksi perilaku atau hasil suatu 

sistem. 

 

3D Modeling 

Pemodelan tiga dimensi yang merepresentasikan bentuk bangunan 

secara visual dan detail dalam lingkungan digital. 

 

4D BIM 

Integrasi model 3D dengan dimensi waktu (schedule), sehingga 

memungkinkan perencanaan, penjadwalan, dan simulasi tahapan 

konstruksi. 

 

5D BIM 

Pengembangan BIM yang mengintegrasikan model 3D dan 4D dengan 

data biaya (cost estimation), untuk mendukung analisis anggaran 

proyek.  

 

Viewer 3D 

Aplikasi atau fitur yang memungkinkan pengguna melihat, memutar, 

dan mengeksplorasi model tiga dimensi. 

 

Estimasi Biaya Proyek 

Perhitungan perkiraan anggaran yang dibutuhkan untuk melaksanakan 

suatu proyek konstruksi, meliputi material, tenaga kerja, dan biaya 

operasional lainnya. 
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Microsoft Project 

Perangkat lunak manajemen proyek yang digunakan untuk membuat 

jadwal, mengatur tugas, serta mengelola sumber daya. 

 

Excel 

Aplikasi pengolah data berbasis tabel yang digunakan untuk analisis 

biaya, perhitungan, dan jadwal proyek. 
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Latihan Soal – BIM Simulation  

A. Pilihan Ganda 

1. BIM (Building Information Modeling) merupakan teknologi 

yang digunakan untuk… 

a. Mendesain bangunan secara manual 

b. Menggambar 2D dengan cepat 

c. Memodelkan, mengelola, dan menganalisis informasi 

bangunan secara digital 

d. Menyusun laporan keuangan proyek 

2. Integrasi model 3D dengan dimensi waktu dalam BIM dikenal 

dengan istilah… 

a. 2D BIM 

b. 3D BIM 

c. 4D BIM 

d. 5D BIM 

3. Perangkat lunak yang umum digunakan untuk penjadwalan 

proyek dalam BIM adalah… 

a. AutoCAD 

b. Microsoft Project 

c. Photoshop 

d. SketchUp 

4. Salah satu kelebihan penggunaan BIM dalam pembelajaran 

adalah… 
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a. Mengurangi interaktivitas pembelajaran 

b. Meningkatkan pemahaman konsep dengan simulasi digital 

c. Membatasi kolaborasi antar mahasiswa 

d. Membuat proyek lebih lama selesai 

5. Integrasi BIM dengan biaya proyek (cost estimation) dikenal 

dengan… 

a. 3D BIM 

b. 4D BIM 

c. 5D BIM 

d. 6D BIM 

B. Isian Singkat 

1. Sebutkan dua manfaat utama penggunaan Viewer 3D dalam 

BIM Simulation! 

2. __________ digunakan untuk mengolah data biaya dan 

penjadwalan dalam BIM. 

3. Kuis pra-pelatihan dalam pembelajaran BIM berfungsi untuk 

__________. 

4. Penambahan dimensi waktu dalam BIM dikenal dengan istilah 

__________. 

5. Feedback dosen dalam media pembelajaran digital berfungsi 

untuk __________. 

C. Uraian 
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1. Jelaskan perbedaan antara 3D, 4D, dan 5D BIM dalam 

penerapan proyek konstruksi! 

2. Bagaimana peran digital simulation dalam meningkatkan 

pemahaman mahasiswa terhadap konsep BIM? 

3. Mengapa integrasi Excel dan Microsoft Project penting dalam 

pembelajaran BIM Simulation? 

4. Berikan contoh bagaimana BIM dapat membantu 

memvisualisasikan dampak perubahan desain terhadap waktu 

dan biaya proyek. 

5. Menurut Anda, apa tantangan terbesar dalam penerapan BIM di 

dunia pendidikan, dan bagaimana solusinya? 

Soal Analisis BIM Simulation (Berkelompok) 

1. Amati gambar 3D berikut. Identifikasi elemen 

arsitektural utama (dinding, atap, kolom dan balok) 

yang ditampilkan. Apa informasi yang bisa diperoleh 

dari masing-masing elemen tersebut dalam konteks 

BIM? 
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Gambar Dinding 

 

Gambar Atap 
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Gambar kolom 
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Gambar Balok 

2. Berdasarkan gambar 3D struktur bangunan yang 

ditampilkan, analisis bagaimana hubungan antar 

elemen struktur (balok dan kolom). Bagaimana BIM 

membantu mendeteksi potensi konflik (clash 

detection) antar elemen tersebut? 

3. Analisis gambar 3D yang menunjukkan integrasi 

instalasi mekanikal, elektrikal, dan plumbing (MEP). 

Bagaimana BIM mempermudah koordinasi antar 

disiplin pada tahap ini? 
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4. Perhatikan simulasi 3D yang menampilkan tahapan 

pembangunan (4D). Identifikasi tahapan konstruksi 

yang ditunjukkan dalam gambar, lalu jelaskan 

bagaimana informasi tersebut dapat mendukung 

manajemen proyek. 

5. Dari model 3D yang dikaitkan dengan estimasi biaya 

(5D), tentukan bagian bangunan mana yang 

kemungkinan membutuhkan biaya terbesar. Jelaskan 

faktor-faktor yang memengaruhi perhitungan biaya 

tersebut. 
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